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Introduction

The nVision Actuals Drilldown Report is a valuable tool that can be used to manage your budget and
expenditures. This report can only be used with valid non-project speedtypes for the fund codes
10xxx, 14100, and 15000. The nVision Actuals Drilldown report presents summarized budget and
expenditure data for a specific speedtype and as of date. The drilldown functionality gives you the capability
of viewing detailed transactional data by double-clicking on the total amounts shown on the spreadsheet. The
only amounts you are not able to drill down on are the amounts in the Free Balance column.

Logging into Spectrum

1. Open Internet Explorer Browser, type http://www.spectrum.gsu.edu in the URL
address.
2. This will take you to the Sign In page of Spectrum (PeopleSoft Financials v8.9).

\

GeorglaStateUmversny.

Spectrum+ Financial System

User ID {TESTUSER1

Password [.o.o.o.ol{ ]

3. Enter your Campus ID in the User ID field and your Campus ID password in the
Password field. Press the Sign In button to enter PeopleSoft Financials.

NOTE: You must have security access to Spectrum Financials before you can login. To obtain access,
go to http://tools.finance.gsu.edu/browse-by-function/?gf search=spectrumf and fill out Spectrum
Plus User Access Request Form. If you do not know your campus id and password, please refer to the
following URL for additional information, https://campusid.gsu.edu/index.cfm
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Accessing the nVision Actuals Drilldown

4 | The Home page of PeopleSoft Financials is displayed.

My Favorites

Navigator

Classic Home Kems

ORACI_E ¥ My Homepage /ﬁ\ \ o
Query Viewer GSU Workcenter Report Manager Process Monitor
e = @ a
5 | Navigate to the nVision Actuals Drilldown.
GSU > GSU Reports > nVision Actuals Drilldown
NavBar: Navigator
GsuU
:©
Recent Places BOR Customizations

* Customers

Products
Customer Contracts

Customer Retumns

Cost Accounting
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Recent Places

*

Navigator

Classic Home

NavBar: Navigator

. =

My Favorites

NavBar: Navigator

GSU Budget

Grants Projects

Interfaces

GSU Reports

OneUSG

GSU Queries

Spectrum Approval form

Recent Places

¢ GSU Reports

Budget Free Balance Report|

ADP/GL Compare Report

Project information

nVision Project Drilldown

nVision Capital Drilldown

Print Journal Line
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6. | If this is your FIRST time accessing the nVision Actuals Drilldown, click on the Add a New
Value tab. Notice that the Run Control ID defaults to “DEPTFBB3.” Please DO NOT CHANGE
the default value. You will not get data if the Run ControJAD is changed.

ORACLE All

nVision Actuals Drilldown

Find an Existing Value

Run Control ID:|DEPTFBB3

Add

Press Add

Note: Once you add this Run Control ID, the system saves the Run Control ID. The next time
you access this report, go to the Find an Existing Value tab and Press Search. Select the Run
Control ID from the search results.

ORACLE All «| Search » | Advance

nVision Actuals Drilldown

Enter any information you have and click Search. Leave fields blank for a list of all values.

\ Find an Existing Value Add a New Value

Search Cnteria

Search by: Run Control ID begins with

Case Sensitive

‘.fanced Search

7. | The Parameters page is displayed.
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Run nVision Actuals Drill Down

Run Control ID DEPTFBB3 Report Manager Process Monitor Run
Business Unit: GSUFS @, As of Date: |09/30/2015 |[}] Fiscal Year: 2016 SCQOE”“”g 3
eriod:

SpeedType Key &,

/ Descr \

Fund Code

Department
Program Code

Class Field
\ Project /
/

Enter the SpeedType in the SpeedType Key field or select a SpeedType using the Lookup function

(magnifying glass). Once you tab out of field, the system will populate the speedtype
description and the other chartfield values for the speedtype key you entered. Do Not Use a
10-digit Project Speedtype.

7a | Business Unit: Defaults to GSUFS

As of Date: Initially the As of Date defaults to the last day of the current month. After that the
system will default the As of Date you ran the report last. The As of Date drives the values in
Fiscal Year and Accounting Period. You may change the As of Date to any end of month date
including previous fiscal year.

SpeedType Key: Enter a valid non-project speedtype key.
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8. | Click on Run which automatically saves report parameters.

ORACLE All ~| Search

Run nVision Actuals Drill Down

SpeedType Key SPECT Q@

Descr Spectrum System - Tuition
Fund Code 10500
Department 612250000
Program Code 16200

Class Field 11000

Project

Run Control ID DEPTFBB3 Report Manager Process Monitor Run

Business Unit: (GSUFS |@, As of Date: 09/30/2015 |[5] Fiscal Year: 201

Advanced Search

6 Accounting ~
Period:

9. | The Process Scheduler Request page is displayed.

Process Scheduler Request

OK Cancel

Drilldown.”

‘ Saved ’
UserID TESTUSER1 Run Control ID DEPTFBB3
Server Name | PSNT v Run Date 09/28/2015 El
Recurrence v Run Time |11:10:16AM Resetto Current Date/Time
Time Zone @,

Process List
Select Description Process Name Process Type *Type *Format
v Actuals Drilldown DEPTFBB3 nVision Report Default v | |Default v

Server Name may be blank or default to PSNT. PLEASE DO NOT CHANGE ANYTHING ON THIS
PAGE. Press OK. The system returns you to the previous page, “Run nVision Actuals

10 | Notice the system assigns a Process Instance number. Use this number to track the status of
your report. A new number is assigned each time you run the report.
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Run nVision Actuals Drill Down

Run Control ID DEPTFBB3 Report Manager Process Monitor Run
| Process Instance:9747 |

Business Unit: (GSUFS|@, As of Date: 09/30/2015 5] Eical Year: 2016 SC‘?O;”U"Q
eriod:

w

SpeedType Key [SPECT @

Descr Spectrum System - Tuition
Fund Code 10500
Department 612250000
Program Code 16200

Class Field 11000

Project

Click on Process Monitor link located in the top right section of page to view the report
status. You will not be able to access the report from the Process Monitor/Process List page.
The report can only be accessed through Report Manager.
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11. | Click on the Refresh button until the Run Status is “Success” and the Distribution Status is “Posted.”
Wait at least 15 — 20 seconds between each time you press the Refresh button. The report is ready to
be viewed when the Run Status is Success and Distribution Status is Posted.

Process List Server List
View Process Request For
User IDTESTUSERT | @, Type v || Last v 1 |Days v
Server v Name @, Instance to
Run Status hd Distribution Status Y | ¥ Save On Refresh
Process List Personalize | Find | View All | B | 2] First'4' 1 of 1 '®' Last
Select Instance Seq. Process Type Process Name User Run Date/Time Run Status lgti::jts)utior Details
9747 nVision Report DEPTFBB3 TESTUSER1 09/28/2015 11:10:16AM EDT Success Posted Details
Go back to nVision Actuals Drilldown Process Instance # is referred
& save |[=] Notify to on previous page.
Process List | Server List
Click on the link, “Go back to nVision Actuals Drilldown.
12. | The system returns you to the nVision Report Request page. Click on the Report Manager link to view

the report.

Run nVision Actuals Drill Down

Run Control ID DEPTFBBE Report Manager Process Monitor Run

Business Unit: GSUFS @, As of Date: [09/30/2015 |5 Fiscal Year: 2016 QC9°3"‘i”9
eriod:

w

SpeedType Key SPECT @,

Descr Spectrum System - Tuition
Fund Code 10500
Department 612250000
Program Code 16200

Class Field 11000

Project

NOTE: You can wait a few minutes to allow time for the report to run completely and click on Report

Manager. The report will not appear in Report Manager until it has completely finished processing.
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13. | Click on the link, Department Free Balances to view report.
List Explorer
View Reports For
Folder v Instance to Refresh
Name Created On [ |Last v Days v
Reports Personalize | Find | View All | & [ B First' &’ 12012 V) Last
T Completion Report Process
Report Report Description Folder Name Date/Time D listance
. |Department Free] = DEPARTMENT FREE " 09/28/15 S -
BALANCES Genera) 12:00PM Bbniaa e
14. | Click on DEPTFBB3.xIs (Name will be the same for every user).
Report
Report ID: 1860126 Process Instance: 9747 Message Log
Name: NVSRUN Process Type: nVision-Report
Run Status: Success
Department Free Balances
Distribution Details
Distribution Node: F920QA Expiration Date: 10/05/2015
File List
338 File Size (bytes) Datetime Created
DEPTFBB3xls 650,752 09/28/2015 11:13:12.354940AM EDT
Distribute To
Distribution : :
ID Type Distribution ID
User TESTUSER1

Important Note: Please DO NOT RUN multiple nVision Actuals Drilldown reports simultaneously.

You must wait until the first report has completely run with a Run Status of Success and Distribution
Status of Posted before running another report. For example, if you run the report with Speedtype A,
Speedtype B and Speedtype C within a minute apart, Speedtype A and Speedtype B will get overlayed
with Speedtype C data. So all three reports will have the same data.
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will automatically open the spreadsheet.

-
Windows Internet Explorer

What do you want to do with DEPTFBB3.xls?

From: reports.f92qa.spectrum.gsu.edu

< Open
The file wop't be saved automatically.

2 Save

< Save as

Cancel

~

Click on Open and the report will appear on screen.

15. The File Download message box appears if the ‘Always ask before opening this type of file’
checkbox is checked. If it is unchecked, you will not see the File Download message box. The system

Note: If you experience any problems opening the report or drilling down in the report, please refer
to the “Troubleshooting nVision Report Issues” section found on page 30.

You may have a pop-up blocker. If this occurs, HOLD the CONTROL button down on your keyboard
while you press Open. Please follow the instructions in ‘Updating Your Trusted Sites” Quick
Reference Guide, http://www2.gsu.edu/~wwwspc/Training/QR_UpdatingYourTrustedSites.pdf to

prevent this from occurring.
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http://www2.gsu.edu/~wwwspc/Training/QR_UpdatingYourTrustedSites.pdf

16. | Click on Enable Content to enable macros.
=] 5 DEPTFBB3.xs [Read-Only] [Compatibility Mode] - Excel
HOME INSERT PAGE LAYOUT FORMULAS DATA REVIEW VIEW DEVELOPER ADD-INS TEAM
% Cut . T .l : | H2a By 2
BB Copy - Arial [0 - = ¥ B¢ Wrap Text General S& E & X E!:]
Paste . v | &« > = . . o .00 Conditional Fi it Cell Insert Delete F t
& Format Painter Iu b 2~ A = Merge & Center $-% » @08 FG‘:;a'ﬁ'i‘:’“g“’_ ‘_’;:ﬂz:“ Slylees' Lot i
Clipboard & Font 5 5 Number 5 Styles Cells
1 SECURITY WARNING External Data Connections have been disabled
AL - I
A B Cc D E F G
1
=
2 | STACT ( Student Accounts ) 419320000 10000 15600 11000 Fiscal Year to Date as of Se|
3
4 Financial Activity Cl i -
Current Fiscal YTD  Current Fiscal YTD  Current Accting
5 Category ~ |Sub-Category -T|Account ( Description ) > Budget Encumbrances Expenditu
6 =(1) Personal Senrvices =(2) Salaried Employees PSS000 ( Salaried-Budget Only ) 586,329.01
7 2) Salaried Employees Total 586.329.0
8 =(7) Miscell Lump Sums [PLM000 ( Misc Lump Sums-Budget Only ) 6.000.0
9 (7) Miscell Lump Sums Total 6.000.0
10|  |{1) Personal Senices Total 592,329.00
1
12 =(2) Non-Personal Serviceq =/(1) Travel [NTR000 ( Travel-Budget Only ) 10.000.00
13 (1) Travel Total 10.000.00
14 =(2) Operating Supplies and Expense{NSP000 ( Oper Supplies & Ex-Budget Only ) 100.000.00
15 (2) Operating Supplies and Expenses Total 100.000.00
16 (2) Non-Personal Services Total 110,000.00
17. | The Microsoft Office Security Options page is displayed.

Security Warning ‘i‘

|24y

@ Do you want to make this file a Trusted Document?

This file is on a network location. Other users who have access to this
network location may be able to tamper with this file.

What's the risk?

[7] Do not ask me again for network files

;

Select Yes to enable Macros.
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Using the nVision Actuals Drilldown

This report will only display accounts that have expenditure activity. In (Figure A 1) below, there are
no travel expenditures for the speedtype, SPEC for the as of date 10/31/2010, so you will not see any
expense accounts beginning with 6XXXXX listed in the dropdown list for the Account column. The
nVision Report can be saved in Microsoft Excel. The nVision report has filter features. You can apply
filters on your data to include or exclude categories, sub-categories and/or accounts. Filters can also

be used to view or hide certain columns or rows of data on the nVision report. Columns which have

filters are indicated by a dropdown arrow = | Columns which have filters established are indicated by

a picture of a filter ""'|. Filters are talked about more in detail on page 19.

SPEC ( Spectrum System } 612250000 10000 16200 11000

Fiscal Year to Date as of October 31, 2010

Financial Activity

Classification hd

Current Figcal YTD  Current Fiscal YTD Current Accting Per  Prior Budget Pericd  Current Fiscal YTD
Category > |5ub-Category 7| Account { Description | Budget Encumbrances Expenditures Expenditures Expenditures Free Balance
= (1} Perzonal Services =l (2) Salaried Employees S21100( S es - Prof & Admin ) 141,188.44
PSS000 { Salaried-Budget Onby 481.481.00
(2) Salaried Employees Total 451,481.00 141,188.44 320,282.55
(1) Perzsonal Services Total 451,481.00 141,188.44 320,282 .56
= (2) Non-Perzonal Servic] 51 (1) Travel [NTRO0O { TravelBudget Only ) 1,000.00
(1) Travel Total 1.000.00 1,000.00
=I(2) Operating Supplies and Expeng 0 ( Purchase Card Transactions ) 105.75 1,248.0
2 ( Repairs And Maintenance )
Soft 25.00 2500
Cemputer Center Printing Sery ) .70 0.00
Computer Purch Less Than 3000 )
771100 { Telecemmunicatien - Lecal ) 1,520.00 184.64 738.56
NEPOOO ( Oper Supplies & Ex-Budget Only ) 10,000.00
(2] Operating Supplies and Expenses Total 10,000.00 1,520.00 270.69 5.238.52 2,009.63 5.470.37
(2) Non-Personal Services Total 11,000.00 1,520.00 270.69 5,238.52 200883 7,470.37|
Grand Toetal [ 472 481.00 1,520.00 35,892.27 5238.52 143,208.07 327,752.93)
e—— — — — — —— ——

Figure A 1 (Columns you can filter are highlighted in yellow)

If you do not have activity for a category, sub-category or account, it will not get displayed on the

spreadsheet. By double-clicking on a category or sub-category, it is reduced to the summary line. In
the example below, the category (non-personal services) has been reduced to a summary line.

SPEC ( Spectrum System ) 512250000 10000 16200 11000

Fiscal Year to Date as of October 31, 2010

Financial Activity Clazzification s
- Current Fizcal ¥TD  Current Fizcal ¥TD Current Accting Per  Prior Budget Pericd  Curre
Category ~ | Sub-Category =1 account { Description ) Budget Encumbrances Expenditures Expenditures Free Balance
= (1) Perascnal Services |2 (2) Salaried Employees £21100 ( Salaries - Prof & Admin ) 35,621.58
P33000 ( Salaried-Budget Only &
(2} Salaried Employees Total 4 21.00 35,621.58 141,188.44 320,282 56

(1} Personal Services Total 461,481.00 35,621.58 141,198.44 320,282.56]
# (2} Non-Psrsonal Services | 11.000.00 1,520.00 2706 238.52 2,008 \ 470,27
Grand Total I 472.481.00 1.520.00 35,892.27 5238.52 143,208.07 327,752.93
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SPEC ( Spectrum System ) 612250000 10000 16200 11000 A Fiscal Year to Date as of October 31, 2010 B
By
T
Financial Activity Clazzification =
I D - E Curreni‘Fiscal"'B Current Fizcal ¥TD Current Accting Per  Prior Budgst Peried Cur_rent Fizcal ¥TO
Category ~ ¥ |Sub-Category | Account | Description hd &) Budget H Encumorances T Expenditures ) Expenditurss E Expenditures L Free Balance
=I(1) Perzonal Services | [=1(2) Salaried Employees 521100 { Salaries - Prof & Admin ) 58 141,158 24
PSS000 ( Salaried-Budgst Only ) 461.481.00
(2) Salaried Employees Total 451,481.00 141,1588.44 320,282 .56
(1) Perzonal Services Total 461,481.00 3562158 141,198 44 320,282 E&l
=I(2) Nen-Perzonal Servic| =1(1) Travel |H’RCEE { Travel-Budget Onby 1,000.00
(1) Travel Total 1,000.00 1,000.00
=l(2) Operating Supplies and Expeng 714580 ( Purchase Card Transactions ) 105.75 1,245.07
2 ( Repairs And Maintenance } 238.00
( Soft 25.00 1,582.89 25.00
C er Center Printing Serv -2270 0.00
puter Purch Less Than 3000 3,406.63
communication - Local 1,520.00 184.84 738.56
NSP000 ( Oper Supplies & Ex-Budget Only ) 10.000.00
(2) Operating Supplies and Expenses Total 10.000.00 1,520.00 270.59 5,238.52 2,009.63 6.470.37
(2) Mon-Perzonal Services Total 11,000.00 1,520.00 270.69 5,238.52 2,009.63 7470 37|
Grand Total 472.481.00 1,520.00 35,892.27 5,238.52 143,208.07 327,752.93

nVision Actuals Drilldown

A = Speedtype: Displays speedtype, speedtype description and chartfield values associated with
speedtype.

B = As of Date: Displays the fiscal year to date the report was run for. In this example, the report
was run for October 31, 2010. So you will see all budget/expenditure transactions from July 1 —
October 31.

C = Category: Category has a filter. So you have the option to view both personal services and non-
personal services or you can exclude one of these categories.

D = Sub-Category: Sub-Category has a filter. The sub-category values are faculty, travel, operating
supplies and expenses, salaried employees, equipment, graduate assistants, miscellaneous lump sum
and fringe benefits.

E = Account (Description): Account has a filter. This column displays the account and the description.
The account values include budget accounts (i.e. FBBO0O0O, NSPO00, NEQOO0O, NTR00O, PSS000,
PLMOO0O, PSFO00 and PLGO00) and expense accounts (i.e. 5XXXXX, 6XXXXX, 7XXXXX, 8XXXXX).

F = Classification: Classification has a filter. Classification allows you to filter which column(s) you
want to include or exclude on the spreadsheet. The classification values are Current Fiscal YTD
Budget, Current Fiscal YTD Encumbrances, Current Accting Per Expenditures, Prior Budget Year
Expenditures, Current Fiscal YTD Expenditures.

G = Current Fiscal YTD Budget: This is the original budget allotted on July 1 and all transfers (budget
amendments) made during the fiscal year.

H = Current Fiscal YTD Encumbrances: This column shows all open purchase orders and journal
adjustments made to purchase orders for the speedtype and as of date that you specified for the
nVision report. Encumbrances are monies set aside in the form of a purchase order for a specific
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purpose. Purchase Orders are legal binding documents issued by a buyer to a seller (vendor) for the
purchase of goods and/or services. Encumbrances reduce your free balance amount.

| = Current Accounting Period Expenditures: This column displays all the expenditures for a
particular month. Expenditures are actual costs of goods and/or services. Vouchers and journals are
the tools used to record expenditures. This column shows vouchers that have been journal generated
and posted to the General Ledger and posted journals for the speedtype and as of date you specified
on the report. It will not show vouchers that have been successfully budget checked but not posted
to the General Ledger. Only expenditure accounts (5XXXXX, Salaries; 6XXXXX, Travel; 7XXXXX,
Supplies; 8XXXXX, Equipment) will appear on this report. In the example above, the Current
Accounting Period Expenditures column shows all expenditures for the month of October.

J = Prior Budget Period Expenditures: This column records expenditures that are related to prior
fiscal year purchase orders. Example: You establish a purchase order in fiscal year 2010 for $5,500
and no invoices or expenditures are charged against this purchase order in fiscal year 2010. You bring
the encumbrance of $5,500 forward into the new fiscal year 2011. Invoices (Voucher transactions)
that are received and paid against this purchase order in fiscal year 2011 will appear in this column.
This column has no effect on the Free Balance.

K = Current Fiscal YTD Expenditures: This column includes Current Accounting Period Expenditures.
This column shows vouchers that have been journal generated and posted to the General Ledger and
posted journals for the speedtype and as of date you specified on the report. It will not show
vouchers that have been successfully budget checked but not posted to the General Ledger. Only
expenditure accounts (5XXXXX, Salaries; 6XXXXX, Travel; 7XXXXX, Supplies; 8XXXXX, Equipment) will
appear on this report. Current Fiscal YTD Expenditures reduce the Free Balance total.

L = Free Balance: The Free Balance on the nVision Actuals Drilldown is derived as follows:

Current FYTD Budget — Current FYTD Encumbrances — Current FYTD Expenditures = Free Balance
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Using Filters

Filters are organized in a hierarchy. Generally, hierarchies go from left (summary) to right (detail).
Category is the high level key or summary. The category can be further defined into sub-categories
and sub-categories can be further defined into accounts. Account is the lowest level of detail for the
hierarchy. For example: the category non-personal services can be further classified into the sub-
categories of Travel, Supplies and Equipment. Travel can be further defined as accounts beginning
with 6XXXXX; Supplies, 7XXXXX; Equipment, 8XXXXX). Filtering allows you to select which rows and/or
columns of data that you would like to view. You do this by selecting the column dropdown box and
placing a checkmark inside the value box you would like shown on the spreadsheet. Filtering hides
the data values that are not selected. To restore the data values you did not select, click on the
dropdown box again and place a checkmark beside the ‘Select All.” There are multiple ways you can
perform the same filter. For example: To view only non-personal services 1) click on category
dropdown and select only Non-Personal Services or 2) click on sub-category dropdown and select
only Travel, Operating Supplies and Expense and Equipment or 3) click on account and select all the
accounts beginning with 6XXXXX, 7XXXXX and 8XXXXX.

B L O E
- r T
SPEC ( Spectrum|System ) 612250000 1000016200 11000
L J
vV
lEinancial &ctivity Clazzification  [17]
Current Fizcal ¥TD
~ - ~ - |l - ek 4 -
rd LS o —ldlS [ o H ! 5
Category Sub-Category Account { Description Budgst
4 Financial Activity | ) ‘D ation | = ﬁl SortAtoZ
Sub-Cateqary K4 Account ( Description }
A Py art Zto &
Categary = )Lgl SoAtoz SortAtoZ A Sort Zto A
4] sortatez Z] setztos 21| sotZtoA Mare Sort Options...
Al Sort Zto A More Sort Options.. Maore Sort Cptions..
Mare Sort Options... L 3 z .
‘x| Clear Filter From "Sub-Category . L
3 L Value Filters »
3 e
Value Filtzrs » Value Filters e (select Al
Value Filters 3 — — v 4
v [ (Select al) 771100 { Telecommunication - Le & Current Fiscal ¥TD Budget
ES‘EIECt Al [ (1) Faculty [#] FBBOOO { Fringe Benefits-Budget Current Fiscal YTD Encumbrance
s:m‘ o IEES ) (1) Travel [¥NEQOD0 ( Equipment-Budget Onl Current Accting Per Expenditurs
) Mon-+érsonal Services r -
e (2) Operating Supplies and Expe [#MNSPOOD \(Ope' Supplies & Ex"?u' Prior Budget Period Expenditure
(2) Salaried Employees [PINTROOD { Travel-Budget Only ) Current Fiscal YTD Expenditures
[1(3) Equipment [#]PLGOOD { Graduate Assistant-Bur
[7](5) Graduate Assistants [¥]PLMOOO ( Misc Lump Sums-Budge
[ (7) Miscellaneous Lump Sums [#]PSFO00 { Faculty-Budget Only )
[] (&) Fringe Benefits [#]PS5000 { Salaried-Budget Only ) [
< 5 < 3 £ >
T o] (o
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The selections you make on Category supersede the selections you make on Sub-Category or
Account. For example: If you select Personal Services for Category filter, the filter will only display
personal services even if you select travel and equipment for sub-category and accounts beginning
with 6XXXXX and 8XXXXX for the account column. However, you can further define personal services

using the sub-category and accounts within personal services.

Notice that when a column has a filter, it will show the down arrow and a picture of a filter next to it.
This helps you to easily identify columns with filters if you need to turn filters off.

"SPEC { Spectrum System ) 512250000 10000 16200 11000

Financial Activity

Category

Eﬁut-liategcry

Account [ Description )

=l {2} Nen-Perzonal Servic

=I{1) Travel

WTRO00 { TravelBudget Onby |

(1} Trawel T

otal

(2} Mon-Per

zonal Services Total

[Grand Total

Working with the nVision Actuals Drilldown

In this section, we will be using (Figure A 2) to walk you through various exercises.

SPEC ( Spectrum System ) 612250000 10000 16200 11000

Fiscal Year to Date as of October 31, 2010

Financial Activity

Clazzification =
- Current Fizcal ¥TD  Current Fizcal ¥TD  Current Accting Per  Prier Budgst Pericd  Current Fiscal YTD
Category ~ | sub-Categary =T| 2ccount ( Description Budget Encumbrances Expenditures Expenditures Expenditures Fres Balancs
=l(1) Perzonal Services =1(2) Salaried Employees 521100 ( Salaries - Prof & Admin ) 3 14 2.44
PS3000 ( Salaried-Budget Only ) 481,481.00
(2) Salaried Emplayees Total 481,481.00 141,158 44 320,282 56
(1) Pergonal Services Total 461,481.00 141.198.44 320,282, EJEl
=2} Nen-Perzonal Servic| 211} Travel |H’RUUD { Travel-Budget Only 1.000.00
(1) Travel Total 1,000.00 1,000.00
=1(2) Operating Supplies and Expensg 105.7 1,245.0
25.00 25.00
4470 o.00
T ele municatien - Local 1,620.00 1248
NSP0OO { Oper Supplies & Ex-Budget Only } 10,000.00
(2) Operating Supplies and Expenses Total 10,000.00 1,520.00 270.69 5,238.52 2,009.83 6.470.37
(2) Mon-Personal Services Total 11,000.00 1,520.00 270.69 5238.52 2,009.63 7,470.37]
Grand Total 472 481.00 1.520.00 35,892.27 5,238.52 143,208.07 327,752.93
— — — — — — ——
Figure A2

Reminder: You must enable the content for macros each time you open the report. See steps 15 -
21. If macros are not enabled for content, you will not be able to drilldown in the report.
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Exercise 1: Drilldown into the Grand Total of Current Fiscal YTD Expenditures.

SPEC ( Spectrum System )} 612250000 10000 16200 11000 Fiscal Year to Date as of October 31, 2010
Financial Activity Classification -
Current Figcal YTD  Current Fiscal YTO Current Accting Per  Prier Budget Peried  Current Figcal ¥YTD
Category - Category 7| sccount | Description L4 Budget Encumbrances Expenditures Expenditures Expenditures Free Balance|
= (1) Personal Services alaried Employees 521100 { Salaries - Prof & Admin 35 141,188 44
P55000 { Salaried-Budget Only |
(2) Salaried Employees Total 35621.58 141,198.44] 320,282.58
1} Personal Services Total 451,481.00 3562158 141,158 44 320,282 58|
=/ {2} Non-Persconal Servic] =(1) Travel [NTRO0O ( Travel-Budget Only ) 1,000.00
(1) Travel Total 1,000.00 1,000.00
(2) Operating Supplies and Expeng 714990 ( Purchase Card Transactions ) 105.75
715102 { Repairs 4nd Maintenance )
3100 [ Softwars 25.00
2160 ( Computer Center Printing Serv 0.00
744210 { Computer Purch Les= Than 3000
1100 ( Telecommunication - Local ) 1,520.00 738.56
HSPOOO ( Oper Supplies & Ex-Budget Only 10,000.00
(2) Operating Supplies and Expenses Total 10,000.00 1,520.00 270.68 523852 5,470 37
(2} Nen-Personal Services Total 11,000.00 1,520.00 270.89 £238.52 7.470.37]
Grand Total 472,481.00 1.520.00 35,892 27 523859
Double-click on the amount 143,208.07
EXP Grand Total Expenditure Detail
Journal ID Journal DateDepartment Account Fund  Class Program’roject Il Reference  Amount  Description Youcher Pay Reference Pay Date ¥endor I0 Yendor Name OperlD
HRODS15353| 20100730 |7 612250000 |7 521100 10000 F to00 P 18200 F 683090 554442 | D9ADMEZZ-EART FINMPF:
HAODS15393(  200.07-30 7 612250000 |7 52100 10000 ' tooo [ 15200 F 683033 579545 | 03A-0219888-CAPER FINMPR
HAODS15393|  2000-07-30 |7 612250000 |7 52100 [ 10000 ' tooo [ 15200 F 653091 533333 | 09A-0033444-BRANCH FINMPR
HRO0GI5353|  2000.07-30 |7 £12260000 |7 S2too 10000 [ oo F 8200 r ses08z GABEED | 08A-DIETFFE-FORD FINLPF:
HR0SI5353(  2000-07-30 |7 612250000 |7 szmoo Fotoaoo Fonoo Fosz00 [ 65304 WEHMON | 09A-DIZESI-STAMP FINMPF:
HRODSIE057|  2010-08-31 |7 612250000 |7 521100 [ 10000 | 1000 F 15200 I 708s4n T08E3 | 09A-0219885-DARPER FINMPF:
HRODSIS057|  2010-08-31 |7 £12250000 |7 521100 P 10000 000 P 18200 r ooz 554442 | D9ADMEZZEART FINMPF:
HRODSIS057|  2010-08-31 |7 612250000 |7 521100 P 10000 000 P 18200 r Ti00zg BAEEED | 09ADIETFREFORD FINMPF:
HAODSIE097|  2010-08-31 |7 612250000 |7 52100 [ 10000 1000 [ 15200 r Ti0zs 533133 | 09A-0033444-BRANCH FINMPR
HAODSIE097|  2010-08-31 [ 612250000 |7 52100 [ 10000 1000 [ 15200 r oz WEH00 | 09A-DIZEEN-STAMP FINMPR
HROOSI7000( 20100930 |7 £12260000 |7 S2too 10000 [ 000 F 8200 r 7Eesan 583333 | 09A-D033444-BRANCH FINLPF:
HRosI7000(  200-098-30 |7 612250000 |7 s2moo [ otoaoo Fonon Foszo0 r 7sesgt BAEEED | 09A-DIETTREFORD FINMPF:
HRODSI7000(  2000-05-30 |7 612250000 |7 521100 10000 | 000 F 15200 I 7seng: T0833 | 09A-0219885-DARPER FINMPF:
HRODSI7000( 20100930 |7 £12250000 |7 521100 P 10000 000 P 18200 F 75E5g: WEMON | D9ADIZEEN-STAMP FINMPF:
HRODSI7000( 20000930 |7 £12250000 |7 521100 10000 000 P 18200 F 75E5gs 554442 | D9ADMEZZEART FINMPF:
HROOS18071|  201040-29 ¥ 612250000 F° 521100 [ 10000 F 1000 F 16200 F 82007 554442 | 09A0MZZZ-BART FINMPR
HROOS18071|  201040-29 ¥ 612250000 F° 521100 [ 10000 F 11000 F 15200 F sz0073 708333 | 09A-0219888-CAPER FINMPR
HROOEE0F|  2010-40-23 F 612260000 F 6200 |7 10000 1000 F 16200 r sz0080 WEMOD | 08A-DIZEEH-STAMP FINLPF:
HROOG1071|  2010-0-29 F 12250000 F 6etio0 710000 [ fo00 P 16z00 r 20077 583333 | 09A-DI33444-BRANCH FINMPF:
HROOGIE07|  2010-10-29 ¥ 612250000 F G210 [ 10000 F 1000 F 16200 I sznngs BAEEED | 09A-DIETTFEFORD FINMPF:
WKSOSI7265| 20104005 P GIZ260000 P 7M3S0 [ 0000 P 1000 P 16200 r o 0575 | DS WATERS STRAWICKI
WKSOSTPIY| 201009-30 P G12250000 P 714350 [ 10000 F 1000 P 16200 r o250 2706 | STAPLSTOEESE0I3000001 STRAWICK
'KSOS15906|  2010.03-08 I G12250000 ¥ 71330 [ 10000 F 1000 P 16200 r 250 22277 | STAPLSTORSES191B000001 STRAWICKI
wKSOS15906|  2010.03-08 [ B12250000 7 71330 [ 10000 F 1000 P 16200 r 250 9853 | COW GOVERNMENT STRAWICKI
\wkSO5i5a06| 20100808 F E12260000 F TM3s0 [ 10000 [ fi000 P 1sz00 r a0 3102 | DSWATERS STRAWICKI
WSOSIE031| 2000810 |7 612250000 |7 7wasn [ oioaoo P onooo Fosao0 roaan 242 | DS WATERS STRAWICK
WKSISHEE|  2010-07-20 1 BIZZG0000 ¥ TMSA0 [ 10000 1000 F 16200 roasn 32745 | NOSWORTHY TELECOMMUNICAT STRAWICK
WKSOSMZEd|  2010.07-20 P BIZZG0000 P 7MSS0 [ 0000 P 1000 P 16200 r o250 420 | STAPLSTOS4Z07HOO0000] STRAWICK
WKSOSMZEd| 2010.07-20 P BIZZG0000 P TMSS0 [ 0000 P 1000 P 16200 r o250 045 | STAPLS7OE4Z071D000002 STRAWICK
wKSO5M264| 2010.07-20 I B12250000 ¥ 7130 [ 10000 F 1000 F 16200 r 250 ™22 | MOSWORTHY TELECOMMUNICAT STRAWICKI
wKSO5M264| 2010.07-20 I B12250000 7130 [ 10000 F fi000 P 15200 r a0 WEM | AMAZONMKTPLACE PMTS STRAWICKI
wKSO513336| 20100714 F E12260000 F TM3s0 [ 10000 [ fi000 Fo1sz00 r 20 18 | WWWHNEWEGGCOM STRAWICKI
whE513a86| 20100714 F sizz60n0n FoTisan oiooon Fofoo0 Fo1ezo0 F a0 242 | DS WATERS STRAWICK
Fu00si0s] [ 2010028 | E12250000 |7 733100 F 10000 P otoo0 Fosz00 MS-36560 2500 | Soiteare TEMITHI
Floo05i75s2 [ 2010044 | §12250000 |7 742160 P 10000 F 000 P 18200 PSR-G2005 4470 | Computer Center Frinting Ser TSMITHI
Floo0515303 [ 2010-08-19 | £12250000 |7 742160 P 10000 F 000 P 18200 PSR-G2005 4470 | Computer Center Printing Sere TSMITHI
Fi000s18326 | 20101029 612250000 |7 7700 F f0000 Fotooo P 15200 18464 | OCT-2010 Phone MAC STRAWICKI
Fioo0s17566 [ 200.09-30 [ 612250000 |7 7700 P fo0o0 Fotooo P 15200 18464 | SEP-2010 Phane MAC STRAWICKI
Fiooosis727 [ 20f0-08-31 7 612250000 |7 700 P ofooo0 oo F 5200 464 | AUG-2010 Phone MAC STRAWICKI
Fioosisesn | 2000730 [ 612250000 |7 7700 Foiooo0 [ onooo Fosz00 18464 | JUL-2010 Phane MRC STRAWICK
’s click I h ion detail
3. Let’s click on a Journal ID to see the source transaction detail.
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Journal ID HR00515393

Business Unit: GSUFS Journal Date: 7/30/2010 Posted: 9/14/2010

Fiscal Year: 2011 Source: HR User: FINMPR
Accounting Period: 1 Last Modified: 2010-09-14-15.54 45 0000  Status: Fosted to Ledger(s)
Ledger Group: ACTUALS Ledger: Budget Status: Walid Budget Check
Description: ADP Payroll Journals

Journal Totals

Lines: 15.491 Debits: 21.830.221.65 Credits: 21.830.221.65

4. | Notice at the bottom of the spreadsheet that each time you drilldown on an amount or

transaction, a new worksheet is created.

4 4 » M| EXP Grand Totzl || HRO0515393 ]/5ummar-,r T

Exercise 2: Display only Personal Services.

1. Go to the Category column and click on the dropdown arrow.
4 Financial Actiity
4 Financial Actwity i Financial Actmity
- N J 5 Category 7| Suf
‘:l' [Cateqry ziSu 5 | |cateqory EiEN 4} sotatoz
4] sotatoz -
3l sontato 4l sotatoz Z|| sotztoa
%l sonztoa Sqrtzt
ot Zto A More Sort Optians...
More Sort Options...
) More Sort Optians... Wk | Clear Filter From “Categary”
& & | Clear Filter From “Category I y
, Label Fitte
' VYalue Filters »
Value Filters » Value Filters v ]
- v [ (Gelect AN)
v se:e: ::-y i 4 Cliseectah o {1) Personal Services
A Vi (] (ppPersanal Services [7(2) Man-Persanal Services
¥ (2) Non-Personal Services [ (2\don-Personal Services

All of the Value Filters will be selected. Click in the ‘Select All’ box to remove all checkmarks from
Value Filters. Then click in the (1) Personal Services box. Press OK.

2. | Only your personal services are displayed.
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'SPEC ( Spectrum System ) 612250000 10000 16200 11000

Fiscal Year to Date as of October 31, 2010

Financial Activity

Classification =

Current Fiscal YTD

Current Fiscal YTD Current Accting Per

Prier Budget

Period

Current Fiscal YTD

Free Balance

Notice a filter has been added to the Category column.

Categary =T |sub-Category =7 | 2ccount { Description N Budget Encumbrances Expenditures Expendtures Expenditu
=/{1) Perscnal Ser'.'icej} =)(2) Salaried Employees 521100 ( Salaries - Prof & Admin 3582158 141,188.42
PSS000 ( Salaried-Budget Only )
(2) Salaried Employees Total 35.621.58 ILI.ISS.LL\ 320,282.56
(1) Personal Services Tgtal 35,621.58 93.44 320.282.E€|
Grand Tofal 35,621,568 T ideser 52006256

Exercise 3:

Drilldown into Prior Fiscal Year Expenditures column for Repairs And
Maintenance (715102) for the amount of 239.00.

Go to Prior Fiscal Year Expenditures column and find the amount 239.00. Dquble-click on the

SPEC ( Spectrum System ) 612250000 10000 16200 11000 Fiscal Year to Date as of October 31} 2010
Financial Activity Classification = |
Current Fiscal YTD  Current Fiscal ¥TD  Current Accting Per  Prior Budggt Period  Current Fiscal vTD
Category ~ |Sub-Category 7| Account | Description ) - Budget Encumbrances Expenditures Expepditures Expenditures Free Balance|
=I(1} Personal Services | = (2} Salaried Employees SZ1100 ( Salaries - Prof & Admin 35,621.58 141,188.44
PSS000 ( Salaried-Budget Only
(2) Salaried Employees Total 3562158 141,158 ==| 32028258
(1) Personal Services Total 35621.58 141, 44 320‘282.55|
=I(2} Non-Perzonal Servicy |H_RGGG { TravelBudget Onty ) 1,000.00
1,000.00 1,000.00
=I (2} Operating Supplies and Expen: 0 ( Purchase Card Transactions 10875 1,248.07
102 { Repairs And Maintenance
100 ( So ) 25.00 25.00
80 ( Computer Center Printing Serv ) 4470 0.00
210 { Computer Purch Less Than 3000 )
771100 ( ommunication - Local 1,520.00 18464 738.56
NSPOOO { Oper Supplies & Ex-Budget Only | 10,000.00
(2) Operating Supplies and Expenses Total 10.000.00 1.520.00 27068 5,238.52 2,008.63 §,470.37
(2} Mon-Persenal Services Total 11,000.00 1,520.00 2706 5,238.52 2,009.63 7.470.37]
Grang Total 47248100 1.52000 3589227 £2388 14300807 32775293

source transactions.

]
715102 ( Repairs And Maintenance )

The Journal ID and Voucher both have blue lettering so you can drilldown further to see the

Expenditure Detail

Journal ID Jouwrnal Date Department Account  Fund

Class Program®roject IL Reference

Amount

Description

¥oucher ay Referenc: PayDate ¥Wendor ID  ¥endor Name

OperlD

AFPO0GIE131

2010-08-13 r612250000 r TI5102 r 10000 r 11000 r 16200

r 0143768 ‘ 239.00

AppleCare Protection Plan For 01343768 r 01344062

2010-02-13 r942404110

APPLE COMPUTER, INC.

GEUBATCH
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3. | Double-click on the Journal ID, AP00515191 to view journal detail.

715102 { Repairs And Maintenance )

Journal ID Journal Date Department Account  Fund Class Program?roject IC  Reference Amount

APUUE151S1Q 200-0843 [ oetezsooon £ oviswe Fowoon P owooo 15200 Foo1243763 239.00

4. | The Journal Source detail page is displayed.

Journal ID AP00515191

Business Unit: GSUFS Journal Date: 9/13/2010 Posted: 8/13/2010

Fiscal Year: 2011 Source: AP User: GSUBATCH
Accounting Peried: 2 Last Modified: 2010-08-13-23.01.40.0000 Status: Fosted to Ledger(s)
Ledger Group: ACTUALS Ledger: Budget Status: Valid Budget Check
Description: Accounts Payable

Lines: 242 Debits: 610,605.12 Credits: 610,605.12

5. | Anew worksheet is created at the bottom of page for Journal Source Detail page.

M 4 » M| EXP Grand Total | PFY 715102 ]/ AP00515191 . Summary - ¥

< APOOS515191 -

Click on AP00515191 worksheet tab to go back to previous worksheet.

6. | Double-click on Voucher, 01343768 to view detail.

715102 { Repairs And Maintenance ) Expenditure Detail
Journal ID Journal Date Department Account Fund  Class Program?rojectIC Reference  Amount  Description Youcher *ay Referenc: Pay Date Yendor ID Yendor Name OperiD
APUOSISTST | 20100812 rswzzauuuu r 5z r 0000 r oog r 16200 r 0134378 ‘ 2800 | AgpleCare Protection| g, fol TEEES ? Ot4s0sz | 20100812 rsqzquu APPLE COMPUTER, INC. GEUBATCH
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7 | The source voucher transaction detail page is displayed.

Voucher Number 01343768

VENDOR:
942404110 INVOICE NUMBER 9843636512
APPLE COMPUTER. INC INVOICE DATE July 19, 2010
STATUS Open
CREATED August 13. 2010
CREATED BY ROAMNMOLA
LAST MODIFIED August 13, 2010
MODIFIED BY ROAMMOLA,
PURCHASE ORDER ID
PAYMENT REFERENCE [ 01344052
PAYMENT DATE August 13. 2010
QUANTITY DESCRIPTION DIST QTY CIST AMOUNT UNIT PRICE AMOUNT
1 AppleCare Protection Plan for 239.00 239.00
715102 10000 612250000 16200 11000 1 239.00
SUBTOTAL 239.00
TAX
FREIGHT
DIRECT ALL INQUIRIES TO: $239.00
Office of Disbursement Senices
Tel: 404-413-3040 Fax: 404-413-3045 VOUCHER TOTAL

8. | A new worksheet is created for the source voucher transaction detail.

H 4 F M EXP Grand Total PFY 715102 APOOS151591 l 01243768 l Summary ¥

| ——

Click on the Summary tab to go back to the original budget spreadsheet.

Note: Sometimes your worksheets at the bottom of page may become too big and you are no longer
able to see your Summary worksheet. If this occurs, you may delete any worksheets you no longer
need. Do not delete your ‘Summary’ worksheet since this is the worksheet you will be using to
drilldown or filter data. You can also save one or all of the worksheets in Microsoft Excel.
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Exercise 4: Display only the ‘Current Fiscal YTD Budget’ Column Data.

SPEC ( Spectrum Systemn ) 612250000 10000 18200 11000

1 | Go to the ‘Classification” column and click on the dropdown arrow.

Fiscal Year to Date as of October 31, 2010

Financial Activity Classification -
Ai SortAtoZ Currer =cal YTD Current Accting Per  Prior Budget Peried  Current Fiscal ¥TD
c 7 ]su-c 7). pf ¥ | 20T AL I Filt i i
Category Sub-Category =) Account { Descrip] - nual Filters jprances Expenditures Expenditures Free Balance|
=I{1) Personal Services |I=(2) Salaried Employees 521100 ( Salaries il SortZto A -Category 35621.58 141,198 .44
PES000 ( Salaried. 5
2) Salaried Employees Total MorEertDption 3562158 141,158.24] 320,252.5¢)
1} Personal Services Total 35621.58 141,198.44 320282,
=/(2) Non-Personal Servic] = (1) Travel [1TRO00 ( Travel d Y
(T | Total Value Filters > 1,000.00}
=I(2) Operating Supplies and Expeng 714880 ( Purchas — 1027 1,248.0
{Select Ally
25 25
[# Current Fiscal YTD Budget - Eg ‘E Eg
urrent Fiscal YTD Encumbrance e
. C 't Fiscal YTD Ei b
771100 { Telecom A Current Accting Per Expenditure 152000 184 84 38.5
5 { Oper = rior Budget Period Expenditure
NSPOOU { Oper Su Prior Budget Period Expenditu
(2) Operating Supplies and Expenses Total [ Current Fiscal YTD Expenditure: 1,520.00 270.85 2,009.63 5.470.27
2} Mon-Personal Services Total 1.520.00 270.69 2,009.63 74?0.37|

»

checkmarks.

All of your Value Filters are selected, so you want to click in the ‘(Select All)’ box to remove all the

Press OK.

Mare Sort Cptions..

-

Value Filters

B GoectAD |

[] Current Fiscal ¥TD Budget

[] Current Fiscal ¥TD Encumbrance
[] Current Accting Per Expenditure
[] Prior Budget Period Expenditure
[] Current Fiscal YTD Expenditure:

Cancel

Yalue Filters

£ > <

Al sortAtoz 41| sortAtez
Zl| sortztoa 2l sotztoa

Mare 5ot Options...

w

[ (Select All)

[] Current Fiscal YTC Encumbrance
[ Current Accting Per Expenditure
[] Prior Budget Period Expenditure
[] Current Fiscal YTD Expenditure:

l [ Cancel

2 | Once the checkmarks are removed, click in the ‘Current Fiscal YTD Budget’ box to select it.
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3. | Only the ‘Current Fiscal YTD Budget’ column is shown. Please take note that the Classification

ICIaaaificaticn ;'7||

column now has a filter icon next to the dropdown arrow.

"SPEC ( Spectrum System ) 612250000 10000 16200 11000

Financial Activity Claz=ification -l
Current Fizcal vTOD

Category ¥ |Sub-Category | & coount i De=cription | bt Budget
=I{1} Perzonal Servicez | = (2) Salaried Emplovees PSS000 ( Salaried-Budget Onby | 461,481.00

(2} Salaried Employees Total 451,481.00

{1} Perzonal Services Total 451,481.00
=2} Non-Perzonal Servic| =101) Travel |rI_FiI3I3I3 { Trawel-Budget Onby | 1,000.00

(1} Trawel Total 1,000.00

=l (2} Operating Supplies and ExpsnEIHEF'E:EE { Oper Supplies & Ex-Budgst Onby | 10,000.00

(2} Operating Suppliez and Expenzes Total 10,000.00

(2} Non-Perzonal Services Total 11,000.00
[Grand Total | 472 4531.00]

4. | Let’s drilldown to the Grand Total Budget. Click on the amount 472,481.00 to see budget journal detail.

BUD Grand Total Budget Dertail
Journal ID  Journal Date Department Account  Fund Class Program Project|ID Reference Amount Description OperlD
(1000513070 | 2010-07-01 [ 612250000 | MSPO0O [ 10000 [ 11000 [ 16200 [ 2011 10.000.00 FY2011 Org Budget load-track | DFLOYD
(1000513070 | 2010-07-01 [ 612250000 | NTROOO [ 10000 [ 41000 [ 16200 [ 2011 1.000.00 FY2011 Org Budget load-track | DFLOYD
(1000513070 | 2010-07-01 [ 612250000 | PSS000 [ 10000 [ 41000 [ 16200 [ 2011 77.598.00 FY2011 Org Budget load-track | DFLOYD
(1000513070 | 2010-07-01 [ 612250000 | PSS000 [ 10000 [ 41000 [ 16200 [ 2011 47.000.00 FY2011 Org Budget load-track | DFLOYD
(1000513070 | 2010-07-01 [ 612250000 | PSS000 [ 10000 [ 41000 [ 16200 [ 2011 32.566.00 FY2011 Org Budget load-track | DFLOYD
(1000513070 | 2010-07-01 [ 612250000 | PSS000 [ 10000 [ 41000 [ 16200 [ 2011 70.000.00 FY2011 Org Budget load-track | DFLOYD
(1000513070 | 2010-07-01 [ 612250000 | PSS000 [ 10000 [ 41000 [ 16200 [ 2011 66,533.00 FY2011 Org Budget load-track | DFLOYD
1000513070 | 2010-07-01 [ 612250000 | PSS000 [ 10000 [ 41000 [ 16200 M 2011 117.784.00 FY2011 Org Budget load-track | DFLOYD

Please note you are not able to drilldown any further on the Journal IDs because the journals are not in
blue characters. You can only drilldown on transactions that have blue characters.

5. | Anew worksheet is added at the bottom of page for the Budget Grand Totals.

M4 4 » H | BUD Grand Total -~ Summary "]

Note: When you are selecting columns to be displayed for Classification, the Free Balance will appear
only if Current Fiscal YTD Budget, Current Fiscal YTD Encumbrance and Current Fiscal YTD
Expenditures are selected. If any one of these columns is not selected, the Free Balance Column will
not appear.
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Since the nVision Actuals Drilldown is formatted in Excel, you may perform any excel functions such as
printing, sorting, adding comments, adding/deleting lines or worksheets or saving the worksheet.

Printing Excel Worksheets and Workbooks

To print a worksheet

e Click on the Worksheet Tab you would like to print i Sl :Summary |

e Click on the File tab located on the top left corner of page.

e Click on Print tab. (Figure 1)

e Click Print again. (Figure Il)

Print

Copies: |1
=
Print

Printer

Gestetner MP 4002 PCL6

Settings

Account Custom Scaling

Options

Figure | Figure Il
To Print All Worksheets in a Workbook

e Under Settings, choose “Print Entire Workbook”

To Print a Portion of a Worksheet
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e Highlight the section you would like to print

e Under Settings, choose “Print Selection”

Comments
To Add Comments

e Right click on the cell you want to add comments

Insert Comment
e Select Insert Comments - -

o Atext boxis displayed for you to type your comments

= T
GsU:

[ DS WATERS |
STAPLST066551033000001 . 5
STAPLST065691913000001
CDW GOVERNMENT ! .
DS WATERS T
DS WATERS

Notice when a comment is added a red triangle will appear in the top right corner of the cell.
If you move your mouse over the triangle, the comment you typed will appear.

To Display Comments

e Right click on cell which contains comments

¢ Select Show/Hide Comments Show/Hide Comments

To Hide Comments

e Right click on the cell which contains comments

Edit Comment
e Select Hide Comment

™S

Delete Comment

Hide Comment

To Delete Comments

e Right click on the cell which contains comments
e C(Click on Delete Comment
To Print Comments

Ensure all comments are displayed before printing.
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Trouble Shooting nVision Issues

Most problems encountered when running this nVision report fall into two major categories, workstation
configuration and enabling macros. This section will demonstrate how these issues can be resolved
quickly.

Workstation Configuration

The most basic problem is associated with workstation configuration and how your workstation presents
Excel spreadsheets. If your workstation is configured to display Excel spreadsheets within a browser
window, your report will not work correctly. The report will still run and you will see the initial summary
page correctly but drilldowns won’t work and you may see some problems with “Free Balance” formatting
and calculations.

How can | tell if | have a workstation configuration problem?

After your report has opened, look at the task bar at the bottom of your screen. One of the programs
running should be Microsoft Excel. (Figure 1) You should also see the Microsoft Excel icon in the upper left
corner of the report window. (Figure 1a)

BUD PLMO000 | Summary ®

‘W a nxsion Actuals D...

Figure 1
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H - &- = DEPTFBB3.xls [Read-Only] [Co
FILE HOME = INSERT PAGE LAYOUT FORMULAS DATA REVIE\

T b Cut | Arial o ca A =E=E ®-
S ER Copy ~
‘aste v | HE . v v =E=E & =
¥ Format Painter B.E U == O 'A' ==l ==
Clipboard ru Font ] Alignm
E8 v| Jx || 6000
A B &
1
2 STACT ( Student Accounts ) 419320000 10000 156(
3
4 Financial Activity
5 Category L:J Sub-Category !.—t Account |
6 =(1) Personal Senvices =(2) Salaried Employees PSS000 |
Figure 1a

If you do not see Microsoft Excel as one of your running programs (Figure 2) and do not see the
Microsoft Excel icon in the upper left corner of the report window (Figure 2a), you are probably not

configured correctly for this report.

0 ‘ Inbox - couyang... ‘ /= nVision Actuals D...

(Figure 2)

(- https:{freports.f89qa.spectrum.gsu.edu/psreports/F B90A/I34/DEPTFBB3.xIs - Windows Internet Explorer

\Q‘_:'j' =] | & | https:)freports FE9ga.spectrum, gsu. edufpsreporks FE90A) 334 /DEPTFEES. x5

File JEdit  Wiew Insert  Format  Tools  Daka nWisionDrll  GoTo  Faworites  Help

5.7 Favorites | s [ Haw to use Visual Basic for .., 45 ADP Self Service Portal & | FESDEY & | Feoon & Frron EEN Haaoe

‘ ghttps:ll',l'reports.FBQqa.spectrum.gsu.edu,l'psreportsll'F... | |

Al B | c | .
12 SPEC ( Spectrum System ) 612250000 10000 16200 11000
i [Financial Activity [

(Figure 2a)
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How do | fix the problem?

The most efficient way to change file associations is by selecting a default program. This tells
Windows that you want a certain program to be associated with all the file types it can handle.

In Windows 8.1, search for "default programs" on the Start screen and click or tap "Default
Programs."

Search

Everywhere -

default programs

Default Programs

Default app settings

Choose a default app for each
protocol

Choose a default app for each
type of file

In Windows 7, you can search for "default programs" in the Start Menu search box and click the
appropriate search result.
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Programs (1)

@ Default Programs

Control Panel (3) Choose which programs you want
browsing, editing photos, sending e-mail, and |

€ Set your default programs

¢ Change the search provider in Internet Explorer

& Restore desktop gadgets installed with Windows
Documents (2)

ﬂ registrycleaningbackup.reg
THEPERUVIANHO-config-log.txt

Pictures (2)
%) a_081610,s
_‘] sfext-minjs

2~ See more results

‘ default pro| Shut down

While searching is faster, you can also find the appropriate window in the Control Panel: go
to "Programs -> Default Programs -> Set Your Default Programs".

[ 2]
Choose the programs that Windows uses by default

Set your default programs
Make a program the default for all file types and protocols it can open.

E_: BEsOCIate @ IEE__;'FE CFFFCECCC WITH g program

Make a file type or protocol always open in a specific program.

Change AutoPlay settings
Play CDs or other media automatically

] Set program access and computer defaults

Control access to certain programs and set defaults for this computer,

Regardless of which version of Windows you're using, the following steps are the same and the Set
Default Programs window looks and works the same.
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"3 Set Default Programs - 8

.j:j = f B« Default Programs » Set Default Brograms w G| Search Controd Panel »

Set your default programs
To 5ot a peogram o the defpult for ol file types snd pretoccls & can open, click the peogram and then click Set a3 default.

" : A Food & Drink
rogea Mscroscit Corporstion

[ Access (desktop)

!AUMHMﬂHULD-'IOJ Food 8t Drink App - Explore retipet, choote wines snd cocktadls, and
E_':m“ impeove your shlls im the kitcher. Special signature recipes from celebeity
P COBusmer P chefs.

B Eecel (deskieg)

4 File Exploser

@ Firedcn

rossaome 1

Bl Games

EGDM Flayer

Google Chrome .

3 Heatth & Fatness This pregram has all &5 defaulis

 HERE Maps

¥ infopath [desktcr) =+ Set this program as default

Eiﬂbﬂ'nl.'t Explorer Lie the telected prograe to cpen all file types and protacals f can
.l.'m-dle cpen by default.

[ Lymc (desktop) .

il + Choose defaults for this program

Tal Maps > Choose which file types and profocchs the selected program opens by

diefault.
£ *

oK

Once you open the "Set Default Programs" window, select a program or app from the list on the left
side of the window.
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Programs

@Access (desktop)

Adu:-l:le Reader Xl (11.0.10)

Calendar

@CDBurner}(P

Excel (desktop)

il File Explorer

@ Firefox

Plrooagidrine |
mGames

. GOM Player

¢ Google Chrome
EHeaIth & Fitness
* HERE Maps

¥ InfoPath (desktop)
(=2 Internet Explorer
P kinde

m?L}rnc (desktop)

i Mail

EﬁﬁMaps

L4 [ >

To make that program or app the default, thus changing the file associations for all file extensions it is

equipped to handle, click or tap "Set this program as default” on the right side of the window.

This program has all its defaults

< Set this program as default

open by default.

default.

Use the selected program to epen all file types and protocols it can

<% Choose defaults for this program

Choose which file types and protocols the selected program opens by

If you'd like to change only a specific extension, click or tap "Choose defaults for this program."

The screen that opens displays a list of all file extensions your selected app or program can open.

Browse through the list and select any file types you want to associate to your chosen program.

When you finish, click or tap Save.
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= Set Program Associations - o IEH

‘_4'- » 4 [E3 « SeaD.. » Set Program Asso.. v Search Contral Paneal o

Set associations for a program
Select the extensions you want this prograrm te open by default, and then chick Save.

. Firefox
Mozilla Corporation

hittpe fwesnn. rozilla.com

[] Select &N

Name Description Current Default ]
. Extensions

] &].htm  HTML Document Intesmet Explorer

1 &].html  HTML Document Intemet Explorer

O & shtml Chrome HTML Decument Google Chrome

[J2laht  XHTML Decument Imtesmet Explares

[C] = shtml XHTML File Mot selected

Pratocols

I E2FTP  URL:File Transfer Protecal Intemmet Explorer

& wrTe URL:HyperText Transfer Protacel Google Chrome

[J @& HTTPS URL:HypesText Transfer Pratocel with Privacy Geogle Chrome

W

Save Cancel

Your workstation has now been configured to run nVision reports in the Microsoft Excel Application
rather than in a browser window. If you have any copies of nVision reports open they should be
closed. When you open your next nVision report it should operate correctly.
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Enabling Macros

If you open an Excel document that contains macros, you'll see the yellow Message Bar with a shield
icon and the Enable Content button.

If you are sure, the macros are from a trustworthy source, just press the Enable Content button on
the bar.

FILE HOME INSERT PAGE LAYOUT DATA VIEW Ablebits Data
“D ‘_;{":”t Calibri -l -A A = - B
Paste 8 Copy - BE I U Fy = = = &&= 5=
- ¥ Format Painter =T 1=7 A EE== £ =
Clipboard r Font I Alignment
I SECURITY WARNIMG Macros have been disabled. Enable Content

The file will be opened as a trusted document and the security warning will disappear.

Enable macros via the Backstage view

You can also enable macros in Excel using the Microsoft Office Backstage view. You can see the
yellow Message Bar if you click the File tab.

1. Click on the File tab.

H D B -
FILE HOME INSERT PAGE LAYOUT DATA

ﬂ Y -
B J Cut Calibri Ju <A A
Ela Copy -
Paste - - -
- ¥ Farmat Painter O 'E“
Clipboard la Font ]

2. You'll see the yellow Security Warning area. Click Enable Content.

@ Security Warning

Active content might contain viruses and other security hazards. The following
Enable content has been disabled:

Content = MV errs

You should enable content only if you trust the contents of the file,
Trust Center Settings

Learn more about Active Content
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3. You will see 2 features: Enable All Content and Advanced Options. Select Enable All Content to
always make the document's active content available.

The current Excel file will become a trusted document and all macros will be enabled.

@ Security Warning

Active content might contain viruses and other security hazards, The following
Enable content has been disabled:

Content ~ Macros

@ Enable All Content
Always enable this document's active content I}

(rmake this a Trusted Document)

st the contents of the file.

Advanced Options

Select which active content should be enabled.
This content will be enabled for this session only.

o | Control what types of changes people can make to this workbook.
Protect

Workbook ~

How to always run macros for a trusted worksheet

If you create and share workbooks with macros you may want to avoid getting the security message
every time. If you get all your workbooks only from reliable sources, you can choose to instantly run
all macros for all publishers. Below you'll see how to enable all macros in Excel by default.
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1. Go to File -> Options -> Trust Center and press the Trust Center Settings ... button.

| Excel Options @J m1

General @ Help keep your documents safe and your computer i
secure and healthy.

»

Formulas

Proofing Protecting your privacy

Save Microsoft cares about your privacy. For more information about
how Microsoft Excel helps to protect your privacy, please see the

Language privacy statements,

Advanced Show the Microsoft Excel privacy statement

Customize Ribbon Office.com privacy statement

Office Personalized Experience Program

Microsoft Office Feedback "Send a Smile” Privacy Statement

Quick Access Toolbar

m

Add-Ins

Security & more
Trust Center

Visit Office.com to learn more about protecting your privacy and
security.

Microsoft Trustworthy Computing

Microsoft Excel Trust Center

The Trust Center contains security

and privacy settings. These settings
help keep your computer secure, We [ Trust Center Settings... ]
recammend that you do not change T
these settings.

-

| ok || conce |
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2. You will see the Trust Center window. Select the Macro Settings option.

Trust Center

Trusted Publishers
rHErEE PHEERE Macro Settings

Trusted Locations

(1 Disable all macros without notification
Trusted Documents o ) o
@ Disable all macros with notification

Trusted App Catalogs (") Disable all macros except digitally signed macros

Add-ins (") Enable all macros (not recommended; potentially dangerous code can run)

ActiveX Settings .
e Developer Macro Settings

Macro Settings

[] Trust access to the VBA project object model
Protected View

Message Bar
External Content

File Block Settings

Privacy Opticns
3. Select the radio button Enable all macros (not recommended, potentially dangerous code can run).
From now on all macros will run without warning.

Please note that this setting makes your computer open to viruses. You should be sure you get all
workbooks with macros only from the trusted publishers.

Adjust macro settings on the Trust Center window

You can find all macro settings on the Trust Center window. These settings let you adjust the way you
want to work with macro-enabled workbooks.

Please see all the macro settings explained below:

¢ Disable all macros without notification. Macros and security alerts regarding them get turned
off.

o Disable all macros with notification. If you select this radio button, macros will be disabled,
but security alerts will appear if there are macros in a file. It lets you enable macros in Excel
depending on the source.
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o Disable all macros except digitally signed macros. In this case, macros are turned off, security
alerts appear and digitally signed by a trusted publisher macros run. If you have not trusted
the publisher, you are offered to enable the signed macro and trust the publisher.

e Enable all macros (not recommended, potentially dangerous code can run). All macros run
without warning. Please note that this setting makes your computer open to viruses.

e Trust access to the VBA project object model. This checkbox forbids or allows programmatic
access to the Visual Basic for Applications (VBA) object model from an automation client. This
security setting is for the code that computerizes an Office program and manipulates VBA
environment and object model. For automation clients to access the VBA object model, the
user running the code must grant access. You need to tick the check box to give access.
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